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A Note From Larken.
Welcome to Larken automation’s Star CAM CNC control system. The system consists of a frontend layout and design program called Star CAM and a CNC controller called StarCNC.
Use Star CAM to import your designs, layout and edit, and do simple drafting. Tools are assigned to
cut the objects and then the tool path is saved for the StarCNC control popup to spool to the
controller box.
This easy to use system allows you to be designing and laying out your next job in Star CAM while
the last one is cutting. Full multitasking control the way Windows was designed to be.
Please note that the StarCAM program is still being developed and growing ,so please check our
website www.LarkenCNC.com for the latest free updated version.
Larry Kenny
President, Larken Automation Inc.

Contact Larken Automations
By Mail:

By Phone/Fax:

Larken Automation
13-5350 Canotek
Ottawa, ON K1J 9E1

Toll-Free: (800) 591-0049
Ph: (613) 746-5685
Fx: (613) 746-6451

By E-Mail:
Larken@storm.ca

Website:
www.LarkenCNC.com

Copyright Notice
No part of this publication may be reproduced mechanically or in any form without the prior written
permission of Larken Automation Inc. The software described in this manual is furnished under
license and may only be used or copied in accordance with the terms of such license. The information
in this manual is for informational use only, is subject to change without notice and should not be
construed as a commitment by Larken. Larken assumes no responsibility or liability for any errors or
inaccuracies that may appear in this document. StarCAM and StarCNC are registered trademarks of
Larken Automation Inc.
© October 2003, Larken Automation Inc.

Computer Requirements
·
·
·
·
·

Pentium 266+ recommended
Windows 95 ,Windows 98 , ME., XP ,2000,Vista
32 Meg ram minimum recommended
SVGA Color monitor (1024 x 768 min)
Parallel (centronics) port (2 ports if used with a printer)

Note: Starcam updates are available at www.LarkenCNC.com under the tech-support page

Installation
Download the latest Starcam and StarCNC programs from the LarkenCNC.com
website. They are in Zip files so you will need WinZip on your computer to Unzip them.
Create directories (folders) on your C: drive called StarCam and StarCNC.
EG:
and

C:\StarCam
C :\StarCNC

Copy the appropriate Zip file to each directory and unzip them, putting the files in that
directory.
Creating the Icon
Right-Click the mouse on the blank desktop, select from the menu NEW >
SHORTCUT. Use the Browse button to find the StarCam1.exe file in the C:\Starcam
directory and select it and click OPEN. Click. Next, Next and Finish. You should now
have the StarCam Icon on your desktop.
Do the same for the Lspooler.exe file in the
C:\StarCNC directory.
Note: Do not drag the file to the desktop to
create an Icon, since this doesn’t properly set up
the working directory for the program. You can
do this, but you will need to edit the Icon’s
properties and set the working directory to the
correct directory location .

Configuring the Spooler
Run the StarCNC program (Lspooler.exe) and goto Setup>Environment_Setup. You will need
to set the location of the ‘StarCam Spooler Files’ using the Browse button, to the directory
where StarCam is located ( normally C:\StarCam ) and then click the save button.
This tells StarCNC where to look for the ‘Temp0.LKS’ file (temporary spooler file) that
Starcam creates each time that you select and output a job.

Keyboard Control
- Star Cam is designed to use the mouse or keyboard to control cursor movement. To use the
cursor arrow keys, hold down the Alt key at the same time. The cursor will move in the cursorincrement which is displayed at the bottom right of the screen. To change the cursor-increment,
press Alt- PgDn or Alt-PgUp
- You can also enter the cursor increment using Ctrl-PgDn. Very handy for drawing lines, drilling
holes in a pattern and pasting objects in a pattern.
- If objects are selected, you can move them with the cursor keys by adding the Shift key to the Altarrow keys.

Selecting Objects
Objects are selected by clicking on them or windowing them with the mouse. To unselect objects,
hold down Shift while clicking or windowing. To unselect all, double click on a blank part of
the screen or press ESC.
After objects are selected, they can be dragged with the mouse by clicking and holding the mouse
on the center select-node. Double-Clicking on a blank part of the screen unselects all objects.

Gravity Snap(*)
- The * asterisk key is a gravity snap key. It will snap the cursor to the nearest line segment end
or node. It is useful when drawing or selecting objects.

Repeat Drawing command (F3)
Repeats the Last drawing or Create tool-path object command.

Measure Function (F5)
Press F5 and you can measure distance and angle.

Object Properties (F6)
The properties popup displays information about a single object you have selected. Properties
doesn’t display info when more than 1 object is selected.

Typing in coordinates
Typing in Absolute, relative, or Polar coordinates can move the cursor for very accurate cursor
placement. While using these functions, don’t move the mouse. Use the Tab key to move
between data items to enter, then tab to OK and press enter.
Press

;

(Semicolon) to enter absolute coordinates

Press

'

(Apostrophe) to enter relative coordinates

Press

[

(Left Square bracket k) to enter polar coordinates

Zoom Submenu
Right clicking the mouse on the
screen displays the Zoom
submenu.
The 'Z' Zoom
command is almost always active,
even while running other
commands. This is very useful for
moving objects positioned them to
.001" accuracy where you can
zoom in and positioned them to
.001" accuracy.

Zoom Hotkeys
F7 Zoom All F8 Zoom half (centered on cursor)

F9 Zoom double (centered on cursor)

Screen Coordinates
- The screen coordinates of Star cam are exactly the same as on the xy table. The Origin (0,0)*
point on the screen corresponds to the 0,0 point on the table. The origin can be set anywhere in
the drawing as the controller can run in full Plus and minus coordinates. On the Z axis negative
is down and positive is up.

Routing Process Overview
The process flow of running a job on the router is to:

Create your Design
1 - Create the design on your design program Corel-Draw, AutoCAD, Sign Lab, Master Cam,
Surf-Cam etc. and export the data to a HPGL, EPS, DXF or G-Code file. The file must be a vector
file, in an HPGL, DXF or G-code format. (Not a bitmap file such as BMP or JPEG etc.)

Import to Star Cam
2 - Run 'Star Cam' and import your design using the File/ import commands. There are Import
commands for standard HPGL, DXF and GCODE files.

Use the Layer menu to set depths and routing
sequence
3 - You can organize the drawing into layers for better control of
the order of cutting. Layers cut in order from 1 to 50. Also you
can set the depth and other parameters for each layer separately.
Note: The depth setting only applies to non 3d objects that are
designated ‘depth by layer’.
You can also turn off layers and protect layers from editing using
the Status setting.

Layout your drawing
4 - You can then set up the file better for
controlling a router by set/ting direction of
travel, setting depths of cut etc. Star Cam can
also do scaling, copying, moving, rotating and
has many other editing features. It will also
allow you to position drawings on the screen,
and can sort your file to remove unnecessary
tool lifts.

Select Objects to Route
5 - In the Route menu you can
select Router All or Route
Selected depending on what you
want to cut. Select one of these
commands to send the router file
to the Star Cam Spooler
program.

Run the StarCNC Spooler
6 - Run StarCNC from an Icon on the desktop. This runs
the StarCNC Control Spooler that controls the router table.
The spooler program sends commands to the Motion
Controller in the Black box to move the 3-axis router table.
-

You then switch to StarCNC, which runs your file and
controls the XYZ table. For information on using the
StarCNC program, see that section in this manual.

LAYERS
The Layer menu is an important part of the Star CAM program.
Layers allow you to separate the drawing into easily
controllable sections.
Each (section) Layer can have a different depth, speed or
tool#. You can turn off layers that you don’t want to cut or
protect layers from being edited. Also cutting order is easily
controlled as it cuts from top (layer1) down in the Layers
Menu, a maximum of 50 layers are available
Two types of depths within objects
There are two types of contours depth control within Star
Cam. Layer controlled depth and 3D contours.
When flat 2d objects are imported into Star Cam such as from
CorelDraw using the HPGL or EPS format or flat objects draw
in Star Cam, there is no Z-axis value. Star Cam puts a Flag number into the Z coordinate of each
vector of the contour that is substituted with the Layers depth setting at time of routing. This allows
you to change the depth for cutting easily by just changing one number for each layer at the machine
control. This works well for a lot of 2 ½ D cutting and multiplayer woodworking and sign making.
(Note: The flag number is the value +100. since +100 is 100” above the table this number is never
used for cutting)
When objects are imported using Gcode there is usually a Z coordinate that is imported from the file.
This file is then a true 3d file and the Z value is fixed within the vectors of the contour. The Layer
depth setting does not affect the depth of this type of contour. (Use the Properties command to
display the contour type.)
When importing DXF files, you will be prompted to select whether you want use the Z value within
the file or convert it to a Layer controlled depth.
The Set_Zdepth command in the Edit menu lets you change objects to use Layer depths or a fixed Z
depth setting.
Changing layers and depths
- Select the Layers menu. To set the cutting depth of objects in a layer, move the box with the
cursor keys or mouse to the 'Depth' column and to the layer you want to set (set by color). Type the
depth (negative in inches).
Star Cam uses the words Off, Cold, Hot and Live to describe the status of a layer
Off

- the layer does not show and cannot be edited or referenced.

Cold - the layer shows and can be referenced but cannot be edited.
Hot - the layer shows and can be referenced and edited.

Live - Only one layer can be 'live'. Live indicates the layer that you want newly created objects to
be added to or the layer that you want to move objects to.
-You can select the live layer by clicking the mouse on the word 'Layer' of that layer, or by moving
the cursor to the status column and pressing L. Also clicking in the Live Check column will select
the layer live
- Clicking in the Stat column changes the layer stat to the next type
- You can edit the name for easier Layer reference and clarity.
Tool number
The tool number is used for using manual of automatic tool change routers. This can be set to
prompt the operator to change the tool at run time.
Clicking on the tool list Icon on the bottom of the Layer menu displays a list of the available
tools. To define new tools select the Tool List command in the Tool Path menu
When objects are routed, parameters for selected tool such as xy feed , z feed and RPM etc, are sent
to the controller for that layer.
The tool number is also used when displaying a simulated tool path using the View_ToolFill mode
for that tool on that layer.
XY Feed and Z feed
The XY and Z feed settings are an override of the setting in the tool list. If this setting is not Zero
(0.0) then Starcam will use it instead of the tools feed setting. This is useful is you need to have one
layer run an a slower or faster speed than normal, such as a final light trimming of a part. If these
settings are zero, then they will be ignored.
(Note: Z feed is not used when cutting 3d contours, only on Layer controlled depth contours)
Rotation Angle
On systems with a 4th rotary axis, you can set the angle for the rotary head to turn to before the start
of each layer. This angle is 0 - 360 degrees.
Change Button
To change objects from one layer to another, first select the object on the screen to change, then set
the layer that you want to change them to, to Live. The click the change
button .
Clear Layer Button
Press the Clear button to erase all objects in a layer.
Swapping Layers
You swap Layers order between two layers by dragging the colored square (on the left side) to
another colored layer square. This will change there cutting order.

Menu Commands
FILE MENU
NEW
This command lets you erase the entire drawing so you can start new. Caution data cannot
be recovered after this command.
LOADJOB
This command lets you load a previously saved job. It loads the data along you all
layer information. If there is a drawing in memory be sure to erase it first.
SAVEJOB
This command lets you save the entire state of the job that is in memory. All layer
settings; depths and cutting speeds are saved with the job file. Do not enter a file extension, as the
program will automatically add the 'LKF' extension. Note: LKF files are Larken Format only and not
compatible with any other software. (E.g.: Corel has its native CDR format 'similar concept')
Import HPGL Import an HPGL file at the current cursor position. The sort option should normally
be enabled to sort drawings when they are first imported. This removes unnecessary tool lifts and
negative tool up movements.
For your reference the data in HPGL file looks similar to this: These are 'Select pen'
'Pen Absolute xy' 'Pen down xy' and 'Absolute Arc’ HPGL commands.
SP2; PA0, 0; PD 2543,123;PA1000, 100;AA, 1000,100,180,3;
Import a DXF format file. Lcam's DXF import loads only simple entities.
Import DXF
Blocks, text and curve fit planes are ignored. DXF is useful though for importing 3D lines from Cad
programs such as Design Cad and AutoCAD since Z coordinates are read in.
Note: Use Revision 12 dxf files. R13, R14 ,2000 and above are not compatible.
Note: If you want to erase the Z coordinate values that the DXF has read in to
Starcam, use the Set Z depth command in the Tool menu and set the new depth to
Layer controlled Z depth
Import GCODE Import a Gcode 'NC' file type. Some programs designed to interface with industrial
machine controllers use Gcode. The default file extension is '. NC’. The default format is decimal,
absolute and supports arcs. G00, G01, G02, G03 are supported.
For your reference the data in a Gcode file should look similar to this:
G00 X1.000 Y1.000
G01 X2.250 Y4.500 Z-1.125
M30
Export DXF Export's all the drawing that is visible to a DXF file in 2D format.

EDIT MENU COMMANDS
SELECTING OBJECTS You can window objects with the mouse or click on them to pick them.
To Unselect objects, hold down Shift while picking or windowing them. Its best to window arcs,
because currently StarCam can’t select an Arc, by picking it.
MOVING OBJECTS There are a number of ways to move objects.
- Dragging them with the mouse while selecting the center of the group.
- Moving them with the keyboard, by holding down ALT and SHIFT while using the Cursor keys
- Using the Move command in the Modify Dialog box to enter a move distance.
- You can use the + - keys to rotate the objects as well. The rotate increment is a setting in the
Configuration menu.
COPY
The Copy command copies the selected objects to the Star cam clipboard. You can then
use the Paste and Array Paste commands to place the objects.
Use the mouse or cursor keys to position the object where you want it. You can use
PASTE
the zoom command while pasting objects to get very accurate placement.
Before using the paste command you must have used the copy command.
ERASE

Erases selected objects. Delete is the hotkey.

SCALE
You can scale the object proportionally or non proportionally. If
non-proportionally is selected you can enter separate width and height. Note the
numbers you enter are the actual size you want it to be, not a scale factor. You
can also specify the origin for scale on center or lower left.

MOVE The move command is in the modify toolbox. You can select
absolute or relative positioning.

ROTATE
The Rotate command allows an accurate rotation of the objects
selected. Enter + - 360 Degrees

MIRROR
The mirror command mirrors on center along the Horizontal or
Vertical axis. Use the Undo button to reverse the command

3D commands and Depth control
Layer controlled depth and Zdepth by Setting.
Within Starcam, there are two ways to control the Z depth within a contour . Each contour can
either be a 3D contour, or a 2 ½ D contour with its depth controlled by the Z value in the Layers
menu
3 D contours have a specified Z number value for every vector. 3d is used for carving contoured
surfaces and 3d paths that
2 ½ D contours have a ‘Flag’ in the Z value that tells Starcam to use the Layer menu’s depth
setting for that layer. The advantage of this is easy control of the depth for cutting flat material
such as sheet wood and plastics. Also Starcam can output automatic multi-pass cutting depths for
cutting thick material.
Automatic Multi-Pass for 2 ½ d Objects
To create multipass tool paths, specify in the Layer menu the tool # that you would like to use
for that layer. The ‘maximum depth of cut’ setting for each tool in the Tool Menu specifies how
deep the cuttier will cut in one pass of a Layer controlled object. EG: If the Max depth per cut is
0.25" and the Depth in the Layer menu is 1", Starcam will go around the object 4 times each time
going deeper by 0.25".

SET Z DEPTH
As well as using the layers to set the
cutting depth of an object, you can also assign a specific
depth to an object. This allows an unlimited number of
depths in a drawing for very complex work. Select the
object(s) and then enter the depth.
To reset an object so the depth is controlled by the layer
depth setting, click the ‘Set as layer controlled depth’

LAYOUT MENU
PROPERTIES ( F6 )
Select an entity and this command displays the
path direction, number of segments and whether
the entity is open or closed. Select the Properties
command in the Layout menu or by the hotkey
F6. Click Update to get info.
The properties shows information about the
object such as the Layer its in, the number of
vectors, and its XY size.
The Z depth will show (Layer) if the object uses
the layer depth setting for its depth. If the object
has had a specific z depth assigned to it with the
Depth command then (setting) will appear at the
z depth parameter.
The direction can be reversed by clicking with the
direction button. It will show if the contour is
CW or CCW.
It may show ??? if it can’t determine the direction, but the Reverse Direction will reverse the
direction anyway.
SORT PATH
This command sorts the displayed
layers and connects lines for the fastest routing time. It
also reduces unnecessary tool raises by joining lines that
are not connected but are within the parameter jointhreshold setting.
You can use the Analyze command in the tool menu to
see the number of tool lifts in the drawing before and
after sorting.
The 'start at 2nd vector' setting allows you to manually
set the first vector with the Set_first command so you
have control of where the router goes first. The ‘Allow
Direction Swapping’ setting allows you to prevent the
sort command from changing cutting direction of
contours.

Sorting Examples Below is a simple line drawing before sortingAfter sorting the Rapid tool movement distance had
been greatly reduced.

Note that the sorting started after the 1st vector, and then looked for the closest vector. It checks
each end of the vector to see which is closer and reverses the vector ( if Allow Dir Swapping is
enabled).
Use the Set First command before sorting

Sorting Examples - Joining gaps
Below is a simple line drawing before sorting. The lines are not connected.

The join threshold setting is increased to larger than the gap distance. (This can be measured with
F5). After the sort command, the lines are now joined and are 1 continuous entity (a polyline).

SET FIRST CONTOUR
This command lets you set the order that the entities of a layer will be cut in. Each time an entity is
selected, it will be set to the beginning of the other entities and the entity that was first will now be
second. Therefore to set the order of a group of entities, you have to set them in reverse order.
Use the mouse to Click on a contour to set first
since you can only select one contour. (Don’t use
the window select).

In the example, the rapid moves to the outer
part of the letter B first. This cut order would be
wrong, since the letter would be loose when it
went to cut the middle.

Using the Set first command, the inner cuts were
selected, which moved them to the front of the
layer list. This would require you to use the Set
First command twice, each time selecting one of
the inner contours.
After you use Set First, you can use the
Sort Contours command to re-order the cutting
order starting after the contour you have set first.
The Set first command only works within the
layer, and layers are cut in order from 1-50.
Separating your drawing into Layers is also a
good way to control cut-order.

SHOW DIRECTIONS
This command shows you the cutting direcion of selected object, so you can see if the cut CW or
CCW. ( CW is Climb-Mill, and CCW is Backmill or Conventional mill)
Select the objects first that you want to check and then use this command.

If you need to change the object direction, use the Change Directions command.
CHANGE DIRECTIONS
In the example above, only the lower inside of the letter B need to be changed, so just it is
selected, then the Change Direction command is run. Then the CCW button is clicked to change it
to CCW. Then OK closes the command.

To check the result, select all the objects and use the Show Directions command again.

Now all the insides cut CCW (climb-mill for inside) and the outsides cut CW (climb-mill for outside)
Note - Some objects are too complex for Starcam to determine if they are CW or CCW., which
Starcam displays as Black when using the Show Directions command.
Also to reverse a contour’s direction you can also use the Reverse Direction button in the
Properties command (F6)

ENTRY-POINT
This command lets you
change the position where the
tool enters a entity. Select the
contour , by clicking on it with
the mouse and an 'X' will
appear where the current entry
point is. (Note: do not
window select as you want to
select only one object)
Closed object
A closed object is one where
the last point in the contour is
exactly in the same XY position
as the starting point.
Use the 'F' forward and 'B'
back keys to move the entry
point along the contour. Press
Ok when you are satisfied or
press cancel to abort the
command.
Open Contour
An open object is one where
the last point in the contour is
not in the same XY position
as the starting point.
Use the’ Swap ends’ button
to reverse the contours end
point. Press Cancel when you
are satisfied.
If your contour looks closed
but comes up with the swap
ends box when you select it ,
then its not exactly closed.
Use the Close contour
command in the Layout menu
to close it.

Setting Tool Exit Point
When cutting objects on the router,
setting the best entry and exit point
will keep the piece from being
damaged and nicked when the object
comes free.
It’s a good idea to take at least 2
passes. The final cut should just take a
small amount fo there is little force
when the object is finally cut free.
EG for 1/4" plastic, cut 0.2" for the 1st
pass and then .06"-.075“ for the final
pass.
Since the cutter is turning CW
(clockwise) if the exit point in the
diagram was A then when the letter
was cut free, the letter would want to
move CCW as shown in R. It would
move away from the cutter and not be disturbed.
If the exit point was B when the letter came loose , the letter would want to rotate CCW and
would be self fed into the cutter and be damaged and thrown.

DRAW MENU
In the Draw menu of Star CAM they
are some basic drawing commands that
allow you to do basic CAD. Although
we recommend that you do your
drawing with other Cad and Graphic
programs, Star CAM has some good
drawing features itself.
Lcam has very good cursor control
with the Keyboard and an active zoom
command that allows zooming within
commands.
There are a few features that help
drawing such as Snap to intersection and definable cursor step. Also you can move the cursor with
the mouse, cursor keys or enter the absolute or relative coordinates
Here is a list of function keys useful in drawing.
Alt-Cursor Keys

Move Cursor

Alt-Enter

Enter points

Alt-PgUp

Double Cursor Step

Alt-PgDn

Half Cursor Step

;

(Semicolon)

Enter absolute coordinates

'

(Apostrophe)

Enter relative coordinate

*

(Asterisk)

Snap to intersection

also
F5

Measure distance

F6

Properties for changing directions

There are commands for drawing Lines, Arcs, Circles and box.
When drawing, pressing ESC cancels the command. You can snap to existing geometry while
drawing to get exact connections. Also press 'Z' for zoom and then zoom anywhere while drawing.
Drawing using the Keyboard (no mouse)

You can draw without the mouse (for high accuracy) using the Cursor keys (holding Alt) and use
Alt-Enter to enter points.

TOOL MENU COMMANDS
TOOL LIST The tool list is a user-definable list of up to
30 tools. You will be asked the tool type, diameter, length
(if it is a Vee type), maximum cut per pass, and a 10character tool name. In the layer menu the tool setting
indicates the tool in the tool list that the layer uses for tool
offset, hatching and tool path simulation. When you route
the job, you will be prompted to change tools.

To add a new tool:
Click on the NEW TOOL button, you will be prompted to
enter a name for the tool (ex. ¼” End mill), click Ok to
add your tool name. Choose the Cutter Type and fill in all
information that is applicable to that tool than press then
update Tool to save.

To edit existing tool:
To edit a tool click on it’s name, after you made the changes click on Update Tool to save changes.
The Maxcut/Pass parameter is used by Starcam when you are cutting objects with Layer controlled
depths. This setting is always positive. This is used to multi-pass cut flat 2d objects.
Peck Drill
If the tool is a drill, the Maxcut/Pass parameter is used set the Peck-Drill depth.

The RPM setting will be passed to the controller and will control spindle RPM if the spindle drive is
a variable speed inverter-drive.

ROUTE MENU COMMANDS
This command launches the StarCNC spooler program to run the router file
Enable StarCNC
(temp0.LKS) that Star Cam creates using the Route commands.
(See the StarCNC section in this manual for more information)
This selects all visible data on the screen to be sent to the router controller. (All layers
Route All
except layers turned Off will be routed)
This lets you select just parts of a drawing to be routed. This is very useful if
Route Selected
you need to re-cut a section because of a broken bit or wrong depth etc. Select the parts you want
with the select menu, and then select 'done'. While selecting you can use the zoom command to move
around and refresh the screen.
This command effectively moves the selective objects to the origin and
Route item at Origin
lets you route them there. This command is great when you have a lot of assorted letters to cut on
scraps. Put all the letters in one file and then use this command to route each letter right at origin on
the scrap piece without having to move the letter on the drawing screen.
You can rotate the entire job 90 deg at a time with this command to let you
Rotate all 90 Deg
position the job on your workpiece. This command also does some cleanup of the drawing and can
be used to remove negative move problems.

Set Ending position Select which corner of the object you
would like the router to return to when it’s done cutting. Use
the 'save' in the Parameters command to save this setting.

The StarCNC Spooler
The StarCNC system is comprised of a ‘motion control
processor’ (MCP) circuit board in the control box and a
windows spooler program. The spooler reads either a Starcam
file or a Gcode file and sends it to the MCP buffer. The spooler
also continuously displays coordinates in real time as well as
velocity and status of the hardware. It can spool huge files to
the (MCP) so file size is unlimited.
The PC is connected to the control box by the printer port.
The printer port was chosen over the serial port for its ease of
configuration and its highspeed data transfer.
Note: Be sure to remove any software that directly talks
to the printer port such as Zip drives, File transfer programs,
scanner drivers etc., as these can interfere with comunication
to the controller.

Environment Setup
You may need to change the
printer port setting in the spooler by
selecting the Environment settings in
the setup menu. As you change the
port setting you may need to reset the
controller. If the coordinates in the
spooler display 0.000 then the port is
correct and you have communication.
Be sure to click “Save Setup” when
the correct port is found.
You can preset the default
directories that you will load the
Gcode and Starcam spooler files from.
Selecting Screen mode for Gcode
or StarCam mode selects the
appearance of the StarCNC program. In the Starcam mode the displaybox displays the Layer
table to allow you to turn layers on and off and to set layer depths at cut time. In Gcode mode,
this box displays the Gcode as it is read.
The Controller type can be 3 types : Controller board without interface, with interface
type 11 or with interface type 5-10. If step/direction wires connect directly between the
controller MCP and the Stepper drivers, then you do not have an interface. The interface will
be connected to the MCP with a 25pin ribbon cable. If you have a green interface with plugon
connectors, then it is a type 11 interface. If the interface has mostly soldered-on wires, it is a
type 5-10 interface.
Contact Larken for the correct setting if you are unsure.

Initializing the Controller
The cable used between the PC and the
controller should be a male to female straight
though extendion cable, preferably a new
IEEE shielded type for high speed printers.
With all cables propery connected the
next step is to check that the PC is
communicating with the MCP.
The procedure to start the system is first
to turn the control box on. The Led on the
front of the controller should flash. Then run
the spooler and a message ‘Controller not
Initialized’ should appear. Click OK and wait
about 10 seconds while the spooler initializes
the controller and downloads settings to it.
(You should notice the ‘Feed’ display at the
bottom right run from 1-100)

Configuring the Machine settings
Select the Configure Machine command
in the setup menu to change the motion
control parameters for controlling the CNC
router of 3 axis machine that you are running.
A list of preconfigured setups for Larken
machines is supplied and can be loaded from
the File menu. Goto the File menu and ‘Open
machine Config’ then select the correct file
for your machine. Then use the ‘Set as
Default’ button to have it load automatically
Exit the program and rest the controller and reload after changint the config file.
For custom machines you need to modify settings to make your machine run correctly. If
you have any questions please contact Larken Automation.
Controller Overview
The ‘motion control processor’ circuit board (or MCP) outputs pulses to the 3 (X,Y,Z)
motor drivers to move the machine. The timing between the pulses is controlled in a very precision
way using a digital timer in the MCP. Stored inside the MCP is a table of 100 timer values from
slow to fast. This table is used in acceleration and deceleration to change velocities. The controller

may start moving at table position 10 and gradually move up the table to setting 100 causing
acceleration . These are the motion profile settings seen above (EG: Rapid Vel Max, Rapid Vel
Start)
There are separate settings for Rapid traverse (when the tool is up and the machine is moving
to its next cutting position) and settings for cutting. Also the time the contoller waits on each step
as it moves up the table determines the rate of acceleration.
In addition to the 1-100 velocity table, 4 speed ranges (like a 4 speed transmission) can be set.
The master clock signal to the timer can be set to different speeds to select 4 different speed ranges
of pulses. Typically you would set the speed range to where your machine could reliably move
with Rapid vel max set at its fastest rate (100). The speed range can be set to a slower range for
cutting moves if required as it has a separate setting. The speed range is fastest when set to 0 and
slowest when set to 3.
The Accel parameter sets the rate of acceleration. It is a setting between 0-255 with 255
setting the fastest acceleration. Generally numbers between 210-250 are used. The higher the
number the faster the acceleration. This setting is depends on the weight of the machine and the
performance of the motors etc.
Calibration Factors
To calibrate you xyz table to travel the correct distance, the X,Y and Z scale factors need to
be set.
The setting is defined as - The number of motor steps required to move the 0.001” or
(0.01mm for metric).
EG: if your x axis has a stepper driver that has 1600 pulses per turn, and you are using a lead
screw that has 2 turns/inch then it takes 3200 steps to move an inch. Or to move 0.001” it takes
3.2 steps so you would set the X scale factor to 3.20.
Note: To convert an inch calibration to metric, divide the inch scale factor by 2.54

Using the StarCNC spooler
Jogging
Jogging the machine can be done using the mouse, or keyboard. To use the kenboard, hold
down Alt while using the arrow keys for X,Y and use PgUp and PgDn for the Z axis. Home and
End select fast and slow jog.
Homeing XY and Z axes
Use the Home XY or Home Z buttons to make the machine seek its home switches. It will
set the position to Zero (0) after it homes. Homeing XY and Z speed are parameters in the
Machine configuration .
Setting Origin
To position the tool at a starting point of origin to cut, jog the machine to the required
position and select the Set New XY Position or Set New Z Position buttons.
Selecting the spooler file.
To cut a file you need to select then file first. Using the Open Spool file command in the file
menu and select the file named ‘Temp0.LKS’. Now you will notice that the Run button is enabled.
Note: The ‘Temp0.LKS’ file is created by the Starcam program using the Route objects command.
Running
Click the Run button to start the job. The bottom prompt will display ‘Running’ instead of
‘Local’ .The spindle will start and the machine should start cutting. Press the Estop button or the
Stop button on the controller to stop the job. The controller will automatically stop the spindle at
the end of the job.
Feed Rate Override (FRO)
While the machine is cutting you can speed up or slow down the cutting speed by adjusting
the FRO setting. The change takes place on the next vector , so if you are cutting a long line you
will not see the speed change until the end of that line.

GCODES and MCODES
Gcodes supported
G00 Rapid move

EG: G00X2.5Y10.025

G01 Linear Feed move

EG: G01X3.5Y6Z1.25

G02 Arc X,Y,I J

XY are absolute and IJ are relative.

G03 Arc X,Y I,J
G04 Dwell P 0.25
G83
G84
G90 Absolute coordinates

MCODES Supported
M03

Spindle Start

S - set spindle rpm

M05

Spindle Stop

M06

Pause for tool change T tool#

M08

Auxiliary output 1 ON

M09

Auxiliary output 1 OFF

M10

Auxiliary output 2 ON

M11

Auxiliary output 2 OFF

EG: M03 S16000

EG: M06T5

The 3D Digitizer Probe Option
The 3D Digitizer probe option is available on all Larken routers. To install the probe, remove
router plate and mount the probe instead. The small plug connects to the 2 pin connector next to
the spindle AC power connector.
To test the probe, run the StarCNC program and notice that when you move the tip of the
probe the W axis home indicator on the bottom display bar of the StarCNC should show.
The probe menu is located under the Functions menu. If there is no probe menu, you may
need to contact Larken Automation for an updated security password.
In the probe menu, you can set the size of area you would like to probe. Also the sample
pitch is the probing resolution or the distance between probe samples. Setting the sample pitch too
low will result in very large file sizes and long probe times, since every time you reduce the pitch
by 2, the probing time will take 4 times longer. Also the accuracy of the probe is approximately
0.010”
The probing speed cannot be too high or loss of steps will occur since no acceleration is used
when probing. Generally speed is 15 - 25 %.
Setup for probing : Make sure the object to be probed is securely mounted on the table. The
sharp probe point may mark the surface, so don’t probe delicate items.
Jog the XY axis to the lower left (most negative) corner of the object to probe and set both
X and Y coordinates to 0,0. Set the Z axis to the lowest point that you want probed and set the Z
axis coordinates to zero. Set the X and Y size to the the size of area that you want probed. Ensure
that the Z axis can raise up enough to clear the top of the object with out hitting the Z limit switch
. You can now press the Start Probe button. The pause button allows you to pause the probing
without stopping the job, to make adjustments or fix a bad contact situation.
At any time you can click the Stop button to
stop the system and abort the job. Do not close the
probe window unless the job is stopped or Starcnc
cannot close properly.
When the probing is finished you can save the
3D probed information in a number of formats.
DXF format is a very common format for Cad
programs. The surface is saved in 3D Face entities
(4 sided polygons).
Larken Surfer (L3D) format can be read by
Surfer 3D.
The Gcode option saves the data as a tool path
just as it was digitized in a serpentine contour using
G01 commands. You can put a small plastic ball in

the end of the probe the same size as the cutter that you will use to route it for direct ‘digitize to
cut’ duplication.

Importing Files from other programs
DXF import is the autocad standard, but besure to export the DXF file as a
AutoCADRevision 12 type. DXF versions of R13, R14 and greater are not recommended.
You can also use the HPGL format. You should configure AutoCAD to use a Hewlett
Packard 7585 plotter and set the scale to 1=1. Set 'plot to file' and don't calibrate. You can do a
detailed setup and set pencolors for all 8 pens (8 maximum in AutoCAD). AutoCAD can only
support plots up to 65 inches (at .001" resolution) because the plot variable in AutoCAD is a 2byte value. Use the Plot command in AutoCAD to export the design and give the file a '.PLT'
extension.
Corel Draw is an excellent companion program for StarCam. Version 4 or
Corel Draw!
later is recommended since it has excellent contour (offset) and weld commands command. You
can use the contour commands for cutter offset and object fills. In the example a letter 'B' was
made inside an oval then the 'to center' contour was selected. Generally the objects should be
'welded' before contouring to reduce errors. If you need to access the contours individually
afterwards you must separate and break apart the contours. Use the Export command and select
the HPGL format. The EPS and AI formats also work well especially if you need to enlarge them
afterwards in Starcam since the curves are stored as beziers.

Design Cad 2D for dos Design cad is a very good and quick to use program, and can plot
files any size using its plot command. You should configure the plotter as a HP 7585 plotter and
plot to file. It has some nice single line fonts for small simple engraving and a very good spline
curve command.
Design Cad 2D for windows Unfortunately the windows version doesn't have a plotter
driver so you are supposed to use the windows HP plotter driver and print to file. We have had
limited success with the Microsoft windows driver so we don't recommend using DC2 for
windows.
Design Cad 3D With DC3 you can draw 3d lines and curves for carving with the router.
The Z coordinate should be positive to carve downward. You will then need to transfer the file to
DXF format with the DCFiles utility and use the DXF import command in Starcam to read it in.
Also with our Surfer 3d. 3d tool path program for Windows, you can have your router carve
them out.

Rhino 3d is an excellent 3d
Rhino 3D
modeling program that is also affordably priced. It
makes it easy to draw complex 3d objects for
prototypes and signs etc.
3D Lines , 2d Arcs, circles and other non-surface
extities can be directly imported into StarCam using a
DXF file.
To mill the 3d surfaces with your router you would
need a tool path program such as our Surfer 3D.
Export your drawing in DXF format and import into
Surfer 3D.
The Surfer 3d manual describes the procedure.
For more info on rhino, check out their website at www.rhino3d.com

Surfer3D
Surfer3D by Larken Automation is a program that creates full 3d tool paths from Cad drawings
done in a 3d cad program. The drawing should be made of surfaces and shadeable within the Cad
program. Surfer can import DXF files and generate roughing and the finish planar tool paths with
3d cutter compensation for ball nose, Vee and flat cutters. For more info on Surfer check out our
website at www.LarkenCNC.com

Dedicated Sign making Programs That output Gcode files
The following sign making programs have many features that are more powerful than
Starcam such as tool offsets and tool fills. You may wish to do all the tool path setup in
these programs and just use StarCNC to run the Gcode file. It is a good idea, however to
import the file into StarCam to display it if you have any problems.

CasMate Pro
You will need to install the Larken driver for CasMate for windows.
(contact CasMate or us if it is not on the system disks) There are 2 files 'Larken3d.ENG',
Larken3d.CFG. These should be placed in the caswin directory. - - Go to the 'miscellaneous' menu
and select 'setup' to install the drivers. - Pick the Larken driver and select 'Add'.
EnRoute
Use the same drivers as for CasMate. EnRoute allows you to do a number of
complex tool path types such as 3d carving using a small V cutter and multipassing it to cut a wide

letter. Also you can specify a rough, regular and fine cutter size. It separates the tools into
different layers when you export to Starcam.
Sign Lab
You will need to install the Larken driver for Sign Lab (contact Larken if you don't
have the driver on your system disks). Use install driver from the plotter menu or you can add it to
SIGNLAB2.INI manually in the plotter section.
Use the plot command to create the Gcode file. Set the tool as 'router'. In the color bar you can
double click on a color and set the tool # from 1-20. This will let you transfer different colored
entities to different Layers in Starcam. If you want to use Starcam layer system for depths instead
of setting depths in Sign Lab you can check the setting in the Starcam Gcode import menu.
Turning Arc support 'off' in the sign lab plotter setup command lets signlab have more control of
arc resolution but makes files larger.
Profile Lab You will need to install the Larken driver for Profile Lab (go to
www.LarkenCNC.com , if you don't have the driver on your system disks).
During Profile Lab setup you will be ask if you would like to install drivers (make sure the box is
checked) then click next. This will bring you to the driver installation screen select Larken
Automation, click next.
Note: You can also access the Driver Installation dialog through your Windows Start button:
Program Files/Profile Lab/Driver Installation.

Types of cutting tools:
Wood Router bits - Wood router bits generally are for high rpm cutting of woods and plastics.
They can either be a straight flute or a slow spiral flute; usually they have 1 or 2 flutes. They are
available in Carbide or HSS (high speed steel)
Milling cutters - Milling cutters are for machining metals and are only available as a spiral cutter.
The spiral is a faster spiral (like a finer thread) than a woodcutter to prevent chatter when cutting.
They are also available in HSS and Carbide. Milling cutters are available in 2 - 4 flute. The 2 flutes
are better for clearing chips and are recommended over the 4 flutes. Be sure all cutters you use can
plunge (drill) for tool entry.
Carbide vs. HSS - For most cutting on the Larken systems we recommend using carbide cutters.
They will last many times longer than HSS and produce a better finish; also they can run at higher
rpm and feed rates. The only time you may prefer a HSS cutter is when you need to use a long
very narrow cutter because carbide is more brittle, or where you are machining a very rough metal
where there is a high shock to the cutter.
RPM of Spindle - The Rpm of the spindle is a very important factor when cutting different
materials such as metal. Wood and soft materials can usually be cut at full rpm although plastics
may melt if the feed rate is too slow.
Generally the harder the material, the slower the cutting speed in feet per minute of the cutting
edge of the cutter. If you try to cut a hard material such as brass running the spindle at full rpm,
you will burn and dull the cutting edge of the bit immediately. The larger the diameter of the
cutter the slower you must run it because of its larger circumference.
Feed Rate - The feed rate (how fast the xy table moves the spindle) depends on the finish required
and how much load you can put on the router or spindle. A slower feed rate will usually give a
better finish.
Machining Metals - Metals require much more operator attention than other materials. You must
use a coolant and keep chips clear of the cutter. Also the rpm of the cutter should be 10000 or
less. Do not use cutters with a diameter greater than 1/4" or chattering may cause xy table and
spindle damage.
Set the maximum cut per pass to .05" - 0.1" maximum per pass and set xy cutting speed to less
than 10%.
The z plunge speed should also be set to between 1 and 20%.

Routing and Milling Chart
Material
Spindle Rpm Feed rate Comments
Type
Wood/
24000
20 -100% Use spiral Carbide woodcutters, up or down
Composites
spiral. Adjust feed rate to required finish
quality
Plastics
10000-20000 20 - 100% Use spiral or straight flute wood Router bits. If
feed is too slow, plastic will melt. Adjust Rpm
to feed rate
Foam
Med to high 50-100% Use spiral or straight flute wood router bits. Too
board
slow a feed, and foam will melt. Adjust rpm to
feed rate
Aluminum 16000 for
2-15 %
Use High-Helix spiral 2 flute carbide milling
1/4"
cutters. Use only 6061 or 7075 Grade
Aluminum. (not utility grade 3003 used in sheet
metal shops) Use coolant, clear away chips.
Brass
12000-16000 2 - 15% Use only very sharp spiral carbide milling
cutters. Use a machinable or engraving brass.
Copper doesn't machine well.
Stainless
10000
2 - 10% Use only very sharp spiral carbide milling
steel
cutters. Stainless will wear-harden if the cut is
too light or cutter is dull.

Wood router bit Supplier :
Onsrud Cutter Inc.
800 Liberty drive, Libertyville, ILL 60048
(708)-362-5028 (They have special cutters for plastic also)
1-(800)-234-1560

Milling cutters and coolant:
DoAll Industrial Supply
USA - 2817 N, 37th Ave Phoenix AZ. 85009-1341 (602)-269-7231
Canada - 2655 Rue de Miniac, St-Laurent QC H4S1E5 (514) 337-3631

KBC Tools
USA - 6300 18 Mile Rd., Sterling Heights MI. 48314 (800)-521-1740 or (313)-979-0500
Canada - 6200 Kennedy Rd, Unit 1 Mississauga, ON L5T2Z1 (905) 564-6600

Helpful Tips and Tricks for your Larken Router System
- Separate your designs to different layers for best control of complex jobs. You can give the layers
names for easy reference. Running complex jobs by layer helps reduce human error and lets you
use different tools for different areas.
- The best place for the router to finish cutting out a letter or shape is after a corner if you are
climb milling or just before a corner if you are backwards milling. This pushes the loose part away
from the cutter instead of making the part self-feed into the cutter.
- Using a reverse spiral (down sheer) cutter is a way to prevent parts from coming loose after they
have been cut out. The reverse spiral packs the routed path with material and helps to hold it in
place. This works well with MDF and wood products, not plastics.
-- You can use the 'Rotate Job' command in the router menu to move jobs to the origin easily.
Rotate it 4 times. This positions the work 'cleanly' at 0,0
- For engraving you need a very level work surface to be able to engrave a constant depth without
a floating spindle. You can screw or double-sided tape a piece of acrylic or fiberboard down and
then machine its entire surface making it perfectly flat. You can use the Box command in the Draw
menu and then the tool fill command to create the surface-milling pattern.
-

When making a sign where there is raised letters and a background is to be lowered, it is wise to
run the whole job once to let the tension in the material adjust, and then run the job again with the
tool removing a small amount (0.020" - 0.060”) to get a perfect finish.

Troubleshooting Questions and Answers
Q. Parts cut are wrong size, compared to drawing on screen.
A
1. The wrong configuration (*.mac) file is loaded for your machine. Load the correct
config file
2. The parts you are cutting weren't drawn with the tool offset drawn in.
Q. Z Axis seems to cut deeper and deeper?
A. 1 Setscrews in Z coupler are loose. Turn controller on and try to turn screw with fingers.
If you can turn the screw, remove setscrew to locate flat on shaft. Retighten.
2 Speed settings in Z maybe set too high. Settings to check 'Z_raise vel’, 'Z_first drop, Z
Start vel.
3 Z screw and plastic nut may need cleaning if screw doesn't turn easily between two fingers.
Use Teflon spray periodically
Q. Machine not accurate or circles are not cut round?
A. - There may be Play or loosening in setscrews between motor and/or screws on gears.
Turn controller on (to lock motors), push axis back and forth to find play.
Q. Machine won't respond.
A. 1. Parallel port cable not on properly. Check and secure cable. Zip tie to frame of
equipment if necessary
2. StarCNC is set for wrong parallel port. Try ports1, 2 or 3.
3. Does LED flash when controller is turned on ? (turn controller off for 30 sec)
4. Did controller work on this computer previously ?
5 Does the StarCNC spooler display the S when the stop button is pressed ?
6 Are limit switch indicators (XYZ) on? Click the limit switches on the machine and see
if the program reads them. Is an axis stuck on a limit switch?
7. Call Larken automation Tech support

